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1. Manipulating Charts 
 
Charts are visually appealing and make it easy for users to see comparisons, patterns, and trends in 
data. For instance, rather than having to analyze several columns of worksheet numbers, you can 
see at a glance whether sales are falling or rising over quarterly periods, or how the actual sales 
compare to the projected sales.  
You can create a chart on its own sheet or as an embedded object on a worksheet. You can also 
publish a chart on a Web page. To create a chart, you must first enter the data for the chart on the 
worksheet. Then create a basic chart that you can format later. 
 

1.1 Creating a New Chart 
On the worksheet, arrange the data that you want to plot in a chart and select the cells that contain 
the data that you want to use for the chart. Select Insert  Chart to call up Chart Wizard. Besides, 
the snappiest way to create a chart is to select some data and press [F11]. Excel blasts your data into 
whatever chart style is the current default, placing the result on a new chart sheet. 
 
1.1.1 Step 1 – Choosing a Chart Type 
The wizard’s Step 1 dialog box presents a gallery of chart types and sub-types. You can click [Press 
and Hold to View Sample] button to see what your data will look like in the current sub-type. 
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1.1.2 Step 2 – Specifying the Data to Plot 
In the wizard’s Step 2 dialog box, you can confirm that Excel has properly understood your data 
selection. If Excel has misunderstood your intentions, you should be able to tell at a glance by 
looking at the sample window at the top of the Data Range tab. 

  
 
1.1.3 Step 3 – Choosing Chart Options 
The wizard’s third page is where you make your first aesthetic decisions, such as whether to include 
gridlines, a legend, or data labels. You can also add titles to your chart and its axes here. Each tab in 
the dialog box shows you the effect of your decisions immediately. Bear in mind as you work 
through this dialog box that you can always change your mind later. 
 
1.1.3.1 Specifying Chart and Axis Titles 
The Titles tab lets you assign a title for the chart and descriptive text for each axis. Excel displays 
the text using default fonts, alignments, and positions. Any titles you create become ordinary 
text-box objects, and you can reposition, realign, reformat, and edit them later. 
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1.1.3.2 Specifying Axes 
In all chart types except for pie and doughnut charts, Excel includes value and category axes by 
default. Certain chart types include a secondary value axis by default, you may choose to omit if 
your needs suggest a leaner, axis-free appearance. Note, however, that if you choose to omit an axis, 
all labels associated with that axis are suppressed as well. 
If your category-axis data consists of dates, Excel recognizes that and automatically applies time 
scaling as opposed to category scaling to the axis. In most cases, time scaling is a great convenience 
to you, and you should accept Excel’s decision to apply it. 
Excel usually scales the value axis to begin at 0, even if all your values are in the stratosphere. This 
often results in a chart where all the values are scrunched together in a narrow visual range and 
where differences between one value and the next are hard to discern. Unfortunately, you can’t 
override the default scaling while you’re creating your chart.  

 
 
1.1.3.3 Displaying Gridlines 
Most of Excel’s chart types use some gridlines by default. You can add gridlines or remove them by 
clicking the Gridlines tab.  
Major gridlines emanate from axis subdivisions called major tick marks. Minor gridlines are drawn 
from further subdivisions known as minor tick marks. Excel determines the positions of these tick 
marks automatically, but you can use formatting commands to change their positions. You can also 
alter the colors of the gridlines themselves. 

 
 



Advanced Microsoft Excel    Lesson 3 

CS08204-082-11 @ Peter Lo 2009 4

1.1.3.4 Displaying or Hiding a Legend 
Excel normally displays a legend on the right side of the chart. You can choose a different location 
for the legend or dispense with it altogether by clicking the Legend tab. The Legend tab offers five 
standard locations: Bottom, Corner Top, Right, and Left. You’re not limited to the standard 
locations (Bottom, Corner Top, Right, and Left), however; once you’ve created the chart, you can 
move its legend around at will with your mouse. 

 
 
1.1.3.5 Displaying Data Labels 
The Chart Wizard can attach various kinds of labels to data markers. Pie and doughnut slices, for 
example, can be identified with percentages, absolute values, or both. Columns in a column graph 
and markers in a line graph can have labels indicating the value of each point or the category-axis 
text associated with each point, and so on. Excel does not display data labels by default. To add 
them, click the Data Labels tab. 
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1.1.3.6 Adding a Data Table 
Depending on the type of chart you’re creating, Excel might give you the option of including a data 
table along with the chart. A data table is simply a table of the values from which the chart is 
derived. To include a data table, click the Data Table tab. 

 
 
1.1.4 Step 4 – Telling Excel where to Put your Chart 
Excel can create your new chart either as an object embedded on a worksheet or as a separate chart 
sheet. The fourth and final dialog box presented by the Chart Wizard lets you express your 
preference. However you decide, you can always change your mind later by right clicking the chart 
and choosing Location from the shortcut menu. 

 
 

1.2 Chart Editing and Display Option 
In order to change the editing and display option for the chart, you can select Tool  Options. 
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1.2.1 Changing a Chart’s Size and Position 
Excel creates the chart in a default size and position on an existing worksheet. To change a chart’s 
size while keeping its center stationary, hold down [Ctrl] while you drag. To change a chart’s size 
while maintaining its current aspect ratio, hold down [Shift] while you drag a corner handle. When 
you resize a chart, Excel adjusts the size of all chart text. If you’re not happy with the adjustment, 
you can use formatting commands to increase or decrease the text size. 
If you place the new chart on a separate chart sheet, Excel creates it at a standard size. By default, 
the chart is resized as you resize the window. If you prefer to have the chart stay at the same size 
when you resize the window, activate the chart sheet, choose Tools  Options, go to the Chart tab, 
and clear the Chart Sizes with Window Frame check box. 
 
1.2.2 Plotting Hidden Cells 
Excel normally ignores any hidden rows or columns in a chart’s data range. If you want hidden cells 
to be plotted, create the chart in the normal way. Select any element of the chart, choose Tools  
Options, go to the Chart tab, and then clear the Plot Visible Cells Only check box. 
 
1.2.3 Handling Missing Values 
Excel normally skips over any blank cells in your data range. You have two options: 

 Plot the missing points as zeros. 
 Interpolate the missing points. 

If you interpolate, Excel draws a straight line to bridge the gap created by a missing value; it does 
not actually interpolate a new point. Hence, this option is meaningful only in line, xy (scatter), and 
radar charts, and only in data series that connect points with lines. To change the way Excel handles 
missing points in a chart, select the chart, choose Tools  Options, go to the Chart tab, and choose 
an option button under Plot Empty Cells as. 
 

1.3 Changing the Default Chart Type 
Excel’s default chart type is a two-dimensional clustered column chart. To make a different type of 
chart the default 
1. Create a chart. 
2. Select the chart, and choose Chart  Chart Type. 
3. In the Chart Type dialog box, click Set as Default Chart. 
4. If you find yourself using a particular combination of chart formatting settings again and again, 

add that chart to the Custom Types tab of the Chart Type dialog box, and then make your new 
custom type the default. To add a customized chart, right-click the chart, choose Chart Type, 
go to the Custom Types tab, click User-Defined, and then click [Add]. 
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1.4 Printing Charts 
To print an embedded chart object, you can do either of the following: 
 To print the chart by itself, select it and then choose File  Print. 
 To print the chart with surrounding worksheet data, select any part of the worksheet, but not 

the chart. Then choose File  Print. 
 

1.5 Saving, Opening, and Protecting Charts 
Charts are saved with the workbook in which they reside. To save a chart, simply save the 
workbook file. After you create a chart, you can choose Tools  Protection to lock the worksheet 
or chart sheet containing the chart. Then other people can’t change the sheet and, therefore, the 
chart. The Protection command works the same way for both worksheets and chart sheets. 
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2. Enhancing Chart Appearance 

2.1 Working with the Chart Menu and Chart Toolbar 
The first step in customizing any chart is to select it. If you saved the chart on a separate chart sheet, 
open that sheet. If you embedded it on a worksheet, select it there. When you select a chart object, 
Excel replaces the Data menu with the Chart menu and displays a handy Chart toolbar. 

 
This toolbar normally appears whenever you select a chart and disappears when you select anything 
else. Most users find it helpful and unobtrusive. If the toolbar’s presence becomes an irritant, you 
can click its Close box to send it packing. To make the toolbar visible again, choose View  
Toolbars  Chart. Note that if you dismiss the Chart toolbar while you have a chart selected, 
Excel assumes that you really don’t like the thing and doesn’t bother you with it the next time you 
create or select a chart. 

 
As with any other toolbar, you can move, dock, or reshape the Chart toolbar. Tug on its bottom 
border, for example, and the toolbar transforms itself from a long, narrow rectangle into a 
square-like shape. 
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2.2 Copying Formats from One Chart to Another 
If you’ve already got one chart set up just the way you want it, you can use that chart as a model for 
others. To transfer the formats of one chart to another: 
1. Select the chart area of the chart whose formats you want to copy, then choose Edit  Copy. 
2. Select the other chart, choose Edit  Paste Special, and select the Formats option. 
Note that when you copy formats from one chart to another, you copy all formatting decisions, 
including any scaling choices you made. If your second chart plots values in a different range from 
your first chart, chances are you’re not going to be satisfied with the outcome of the format copy. 
Not to worry; adjust the scaling on the second chart after you’ve completed the copy operation. 
 

2.3 Adding a Customized Chart to the Chart Wizard Gallery 
If you want to use a particular combination of chart formats repeatedly, it’s best to create a new 
entry in Excel’s chart type gallery.  
1. Create the chart that you want to serve as a model for other charts. Select the chart, and choose 

Chart  Chart Type.  
2. Click the Custom Types tab; click the User-Defined option in the Select From group, and 

click [Add].  
3. In the Add Custom Chart Type dialog box, supply a name for the custom chart and a 

description of it. 
To delete a customized chart from the gallery, return to the gallery, click the User-Defined option, 
and select the name of the customized chart type you want to delete, click the [Delete] button, and 
then answer the confirmation prompt. 
 

2.4 Working with Titles 
2.4.1 Creating a Two-Line Title 
One thing you cannot do in the Chart Wizard and the Chart Options dialog box is create a multiline 
title. You can break a one-line title into two or more lines after you have created it.  
Click the title once, pause, and then click again. The first click selects the title, and the second puts 
an insertion point into the text of the title. Position the insertion point where you want a line break 
to appear, and then press [Ctrl] + [Enter]. 
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2.4.2 Formatting a Title 
To change the font, color, border, background, or alignment of a title, you can right-click it and 
choose Format Chart Title to access the Format Chart Title dialog box, 
The idea of a diagonal chart title might seem silly at first. Remember, however, you can drag the 
title onto the plot area if you want. A slanted title on the plot area can make a stylish chart 
annotation.  

 
 
2.4.3 Formatting Individual Characters in a Title 
By formatting title characters individually, you can make your titles look like ransom notes. One 
possible use for individual-character formatting is the characters in the word up have been elevated 
via the superscript option.  
To change the appearance of one or more characters in a title, select the title, pause, and then select 
the characters you want to change. The dialog box that appears has only a Font tab. In other words, 
you can’t change the background characteristics of selected characters. 
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2.5 Working with Gridlines 
Excel automatically adds gridlines, but you can delete them if you decide they're not essential, and 
reduce clutter in the process. Click Chart  Options on the Chart menu after selecting the chart. 

 
 

2.6 Working with Data Labels 
If you delete gridlines, but feel a little insecure without them, you can show your audience the exact 
number of value by the data labels above each column. 
To add data labels, you could click Chart  Chart Options after selecting the chart.  
To reduce clutter, you can also remove other information if it's not necessary. Because the data 
labels show exactly what the numbers are for each column, you don't really need the numbers on 
the vertical value (y) axis on the left. If your chart didn't have data labels, you wouldn't want to 
delete the value (y) axis.  

 
 

2.7 Change Colors and Use Fill Effects 
Excel formats the plot area a standard gray color. But you can choose another color, use no color at 
all, or go wild and use pink or purple for the plot area if that's right for your chart. But your chart 
will have a professional look even if you use plain white when you use fill effects.  
To use a gradient fill, you'd select the plot area, right-click, select the Format Plot Area command 
on the shortcut menu, select Fill Effects, and then select a color.  
A gradient fill was also used for each data series to give the colors some shading and depth. The 
darkest color represents Peacock, whose sales in February were the highest for the quarter, to draw 
attention to her achievement. The gradient fills define each column well enough that borders around 
each column weren't necessary, and could be deleted. 
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In general, avoid putting two dark colors next to each other. The contrast between light and dark 
adds extra emphasis to your data and makes it easier to see the differences between the different 
data series. Greater contrast between colors will also help anyone in your audience who may be 
color blind to read your charts. 

 
 

2.8 Add Finishing Touches 
Give your chart a clean and professional touch by deleting the border from the legend. Select the 
legend, right-click, and click Format Legend on the shortcut menu. 
You can also give the chart more flair by adding a shadow around the chart. You could add shadows 
around the chart and axis titles as well, but make sure the chart doesn't look cluttered. 
Shadows are easy to add. Just click the chart to select it. Then right-click and select Format Chart 
Area on the shortcut menu, and then select the Shadow check box.  
To change an individual title, such as the chart title, go to the Font box on the Formatting toolbar 
and click the font you want. The font of the chart title in the picture has been changed from Arial to 
Georgia. To change all the fonts at once, click the border of the chart to select it, and then click a 
font in the Font box. You might also make text larger or smaller by clicking the Font Size box on 
the Formatting toolbar. Or you could make selected text bold or italic by clicking the Bold or Italic 
buttons on the Formatting toolbar. 
You can also apply specific number formats to the numbers that appear on the chart, just as you 
would in a worksheet. To apply the most common number formats to a selected axis or data label, 
you can use the Currency [$], Percent [%], and Comma [,] style buttons on the Formatting toolbar. 

 

 



Advanced Microsoft Excel    Lesson 3 

CS08204-082-11 @ Peter Lo 2009 13

2.9 Changing Three-Dimensional Viewing Angles 
The simplest way to change the viewing angle of a three-dimensional chart is to select one of the 
chart’s corners and drag it with the mouse. While you’re dragging, Excel displays an outline of the 
chart. This direct-manipulation approach is simple, but you also can easily turn an intelligible chart 
into something quite the opposite. For more precise viewing-angle adjustment, choose Chart  
3-D View. The 3-D View dialog box, provides separate controls for modifying your chart’s 
elevation, rotation, perspective, and height. 

 
 
2.9.1 Adjusting the Elevation 
The Elevation setting changes your viewing angle relative to the floor of the chart. The default 
setting is 15, and you can specify any value from –90 through 90 (With 3D pie charts, you’re 
limited to values from 10 through 80). A setting of 90 places you directly above the chart, as if you 
were looking down on the tops of markers. With a 90 setting, you look up through the chart’s floor 
(which, incidentally, is always transparent regardless of how you format it). To change the elevation, 
type a number in the Elevation box or click the large up or down arrow button in the upper left 
corner of the dialog box. 
 
2.9.2 Changing the Rotation 
Imagine that Excel has anchored your chart to a turntable. The Rotation setting spins the turntable. 
Technically, the rotation setting specifies the angle formed by the category axis and a line drawn 
horizontally across your screen. The default angle is 20o (pie charts = 0). You can specify any angle 
from 0 – 360 by entering it in the Rotation box or by clicking the clockwise and counterclockwise 
buttons to the right of the Rotation box. 
 
2.9.3 Changing the Height 
The Height setting changes a chart’s value-axis-to-category-axis ratio. The default is 100%; you can 
select any value from 5 through 500. The higher the value, the taller your chart. 
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2.9.4 Changing the Perspective 
The Perspective setting determines the apparent depth of three-dimensional area, column, line, and 
surface charts. The default setting is 30, but you can specify any value from 0 – 100. Low values 
make the chart look flatter, as if you were looking at the chart through a telescope or telephoto lens. 
High values have the opposite effect, making it appear as if you were looking through the wrong 
end of a pair of binoculars or through a wide-angle lens. 
The default setting specifies that the far side of the chart is 30% smaller than the near side. This 
means that with a rotation of 0, the back of the floor is 30 percent narrower than the front of the 
floor. Similarly, if the elevation is 90, the bottom of the tallest column in a 3D column chart is about 
30% smaller than the top of the column. To change the perspective setting, type a new number in 
the Perspective box or click the up or down arrow buttons above the Perspective box.  
 
2.9.5 Changing the Axis Angle and Scale 
The Right Angle Axes option sets the axes at right angles independent of chart rotation or elevation. 
To see axes in perspective, turn off this option. This option default as off for 3D column charts. 
Auto Scaling is available only if you have the Right Angle Axes option selected. When you change 
a two-dimensional chart into a three-dimensional chart, Excel sometimes draws it smaller. For 
charts with right-angle axes and a rotation of less than 45o, the Auto Scaling option scales the 3D 
chart so it’s closer in size to the two-dimensional version. 
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3. Working with Chart Data 
 

3.1 Adding Data 
Excel provides several ways to add data to a chart. Excel drew two rectangles around the chart’s 
source data after the plot area is selected. The first rectangle outlines the worksheet range that the 
chart is using for its category-axis labels. The second rectangle outlines the data series. Excel uses 
purple for the first rectangle and blue for the second, to help you distinguish the two. 
 
3.1.1 Using Copy and Paste 
You can use standard copy-and-paste procedures if your chart and its data are close together on the 
same worksheet. Select the new data, and then choose Edit  Copy. Next, select the chart, and 
choose Edit  Paste. Alternatively, you can use Chart  Add Data. Fill in the dialog box by 
typing or selecting the range of new data in the Add Data dialog box. 

 
To extend the chart so that it includes the new data, drag the Fill handle in the lower right corner of 
either rectangle. Alternatively, you can use drag-and-drop by selecting the new data, including its 
category-axis labels. Position your mouse on the border of the selection so that the mouse pointer 
changes to an arrow. Then drag the selection and drop it anywhere on the chart. Excel confirms the 
addition by extending the rectangles to include the new data. 
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3.1.2 Adding Series 
Adding a new series is like adding new points to existing series: Select the data series you want to 
add, copy it, and then paste it onto the chart. If the new data series is adjacent to the existing data, 
Excel has no difficulty figuring out that you want to add a new series rather than some new points.  

 
 

3.2 Removing Data 
The simplest way to remove a data series from a chart is to select the series on the chart itself and 
press [Delete]. This method works even if you’ve refined the selection to a single point in the series; 
delete that point and the whole series is gone. If you try to delete the series by clearing or deleting 
the source data on the worksheet, your chart will still reference the empty or nonexistent cells. 
To delete points from either end of all the series in a chart, select the chart area or the plot area, and 
then drag the Fill handle at one of the corners of either the purple or blue bounding rectangle that 
surrounds your data. To remove points from a particular series, select that series, and then drag the 
blue Fill handle. If the Fill handle isn’t visible, you can always choose Chart  Source Data and 
make your changes there. 
 

3.3 Changing or Replacing Data 
If you drag the lower or upper perimeter of a data-bounding rectangle, rather than its Fill handle, 
Excel moves both the start and endpoint of your series. This can be an effective way to obtain 
detailed views of a chart’s data across the whole range of available data. To switch to an entirely 
different set of data, select any part of your chart, and then choose Chart  Source Data. You can 
adjust the entire chart at once (all series) by using the Data Range box on the Data Range tab, or 
you can work with individual series on the Series tab. 
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3.4 Changing the Plot Order 
To change the order in which series are plotted, select any series and choose Format  Selected 
Data Series; then click the Series Order tab. Use the Move Up and Move Down buttons to 
manipulate the series order. 

 
 

3.5 Adding Trend Lines 
A trend line is a line that describes the general tendency of a data series. To add a trend line to a 
series in an area, bar, column, line, or xy (scatter) chart, first select the series, and then choose 
Chart  Add Trendline.  
If you select Polynomial, indicate the highest power for the independent variable in the adjacent 
Order box. If you select Moving Average, indicate the number of periods should use in its 
calculations in the adjacent Period box. After you’ve indicated the type of trend or regression line, 
select the Options tab if you want a name for the trend line to appear in the chart legend. For linear, 
polynomial, and exponential trend lines, you can also set the y-intercept in the Set Intercept box. 
You can also display the regression equation and the R-squared value beside the trend line plot. 
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3.6 Error Bars 
Error bars express potential error amounts graphically relative to each data marker in a data series. 
For example, you could show 5% positive and negative potential error amounts in the results of a 
scientific experiment: 

 

You can add error bars to data series in a 2-D area, bar, column, line, xy (scatter), and bubble chart. 
For xy (scatter) and bubble charts, you can display error bars for the x values, the y values, or both. 
 
3.6.1 Add Error Bars 
1. On a chart sheet or in an embedded chart, click the data series to which you want to add error 

bars. Click Format  Selected Data Series.  
2. On the X Error Bars tab or the Y Error Bars tab, do one or more of the following: 

 To select a different type of error bar, click the type that you want under Display.  
 To change the method used to determine the error, select the method that you want under 

Error amount. 
 To change a custom error amount, click Custom. In the Plus and Minus boxes, specify the 

worksheet range to use as error amount values, or enter the values that you want to use, 
separated by commas, for example, 0.4, 0.3, 0.8.  

If you change the worksheet values or formulas associated with the data points in the series, the 
error bars are adjusted to reflect your changes. 
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3.6.2 Change Error Bar Settings 
1. On a chart sheet or in an embedded chart, click the error bar or data series that has the error 

bars that you want to change. When you select an error bar, any changes that you make affect 
all of the error bars in its associated data series. 

2. On the Format menu, click Selected Data Series.  
3. Click the Y Error Bars tab or the X Error Bars tab, depending on the type of error bars that you 

want to change, and then do one or more of the following:  
 To select a different type of error bar, click the type that you want under Display.  
 To change the method used to determine the error, select the method that you want under 

Error amount.  
 To change a custom error amount, click Custom. In the Plus and Minus boxes, specify the 

worksheet range to use as error amount values, or enter the values that you want to use, 
separated by commas, for example, 0.4, 0.3, 0.8.  

 
3.6.3 Remove Error Bars 
On a chart sheet or in an embedded chart, click any error bar to remove all error bars in a data series, 
and then press [Delete]. Or you can right-click an error bar, and then click Clear. 
You can also remove error bars immediately after you add them to the chart by clicking Undo on 
the Edit menu, or by pressing [Ctrl] + [Z]. 
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4. Advanced Charting Techniques 

4.1 Choose the Right Chart Type 
Selecting the most effective chart type will make your data clearer, stronger, and more informative. 
Excel offers a wide variety of chart types and simple methods for selecting and previewing them.  
The best chart type is the one that gets your message across most effectively. This may be rich or 
simple, lines or points or parts of a circle, even a combination of several types. The more types 
you've seen and tried, the better you'll be able to choose the right one for your purpose. 
 
4.1.1 A Column Chart Compares Values Directly 
Imagine that you have a worksheet showing how many cases of Teatime Chocolate Biscuits were 
sold by each of three salespeople in each of three months. Now suppose that you want to create a 
chart that compares the salespeople, month by month. 
A Column chart is a good type for comparing values directly, and you want to compare how many 
cases each salesperson sold, so it's a good fit. When choosing a chart type, it's often wise to keep it 
simple, so that your message comes across clearly 

 

 
4.1.2 A Stacked Column Chart Compares Parts of Several Totals 
What if you want to compare contributions to total sales, instead of just case numbers? You can 
place a different emphasis on the same data by creating a different kind of chart, the Stacked 
Column. 
A Stacked Column chart compares the contributions to a total of different values, showing either 
units or percentages. The chart shown here is a 100% Stacked Column chart that shows 
contributions as percentages. 
Instead of comparing how much each person sold each month, this chart emphasizes the relative 
contribution made by each salesperson to each month's total. 
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4.1.3 A Pie Chart Compares Parts of One Total 
What if you want just the big picture? You could create a Pie chart. A Pie chart is designed to show 
comparisons within a single set of values, and to show how parts contribute to a whole. It's an ideal 
chart type to display each month's contribution to a quarterly sales total. 
In the chart shown here, you can see that February accounts for almost 50% of the sales in the first 
quarter. That message wasn't so strong in the Column charts. Pie charts are available in various 
sub-types, such as 3-D, which is visually attractive but can be difficult to understand if it has many 
sections. Again, choose the form of chart that makes your point most effectively. 

 

4.1.4 A Line Chart Compares Values over Time 
A type of chart well suited to showing changes and trends over time is the Line chart. You could 
make comparisons of salesperson performance dramatically visible by showing monthly numbers 
this way. 
Line charts and XY (Scatter) charts look very similar in the Chart type list. In fact they are quite 
different, as you can see in the two charts shown here. It's important to choose the one that will 
work for you. Here are some guidelines to help you choose. 
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 Line charts are good for displaying trends over time in such business numbers as sales, 
revenues, and profits. Use a Line chart if you want dates on the bottom of the chart, to make 
historical developments visible at a glance. Line charts usually have only one set of numbers, 
shown on the vertical axis.  

 An XY Scatter chart compares two sets of numbers at once, one on the horizontal X axis, one 
on the vertical Y axis. The data values are scattered across the chart. You have the option of 
connecting the values with lines, but those lines don't show trends over time. XY Scatter charts 
are good for showing comparisons of numbers such as scientific or statistical data, where 
several measurements need to be plotted on a single chart. If you wanted to show how many 
cases of flu occurred in various age groups, or the average incomes in cities of various sizes, 
an XY Scatter chart would be an effective type. 

 
 

4.2 Combination Charts     
A combination chart uses two or more chart types to emphasize that the chart contains different 
kinds of information. The chart in the example shows one data series (Projected) as a column chart 
type and the other (Actual) as a line. To create this kind of overlay effect:  
1. Create the first chart  
2. Select the data source, copy and paste it into the graph to create the secondary chart 
3. Select Chart  Chart Type and select the secondary chart 
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4.3 Stock Chart 
As its name implies, a Stock chart is most often used to illustrate the fluctuation of stock prices. 
However, this chart may also be used for scientific data. For example, you could use a Stock chart 
to indicate the fluctuation of daily or annual temperatures. 
The way Stock chart data is organized in your worksheet is very important. For example, to create a 
simple high-low-close Stock chart, your data should be arranged with the stock names entered as 
row headings, and High, Low, and Close entered as column 

  

Depending on the type of stock chart you want to create, you must include a specific combination of 
data series in your worksheet — and put the data series in order — as shown in the following table. 
Stock Chart Type Required data series and order 
High-low-close High price  

Low price  
Closing price 

Open-high-low-close Opening price  
High price  
Low price  
Closing price 

Volume-high-low-close Volume traded  
High price  
Low price  
Closing price 

Volume-open-high-low-close   Volume traded  
Opening price  
High price  
Low price  
Closing price 
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4.3.1 Create a Stock chart 
1. Select the data you want to display in a Stock chart. Make sure the data is arranged for the type 

of Stock chart you want to create, as described in the preceding table. 
2. Click Insert  Chart. In the Chart type box, click Stock.  
3. Under Chart sub-type, click the type you want to use. For a quick preview of the chart you are 

creating, click [Press and Hold to View Sample]. 
4. Click [Next], and continue with steps 2 – 4 of the Chart Wizard.  
 

4.4 Surface Chart 
A Surface chart shows a three dimensional surface that connects a set of data points. A Surface chart 
is useful when you want to find optimum combinations between two sets of data. Like a 
topographic map, the colors and patterns in a Surface chart indicate areas that contain the same 
range of values. Unlike other chart types, colors in a surface chart are not used to distinguish each 
data series. Instead, colors are used to distinguish the values. 
When you use this data to create a Surface chart, it will be plotted as follows: 
 The row headings (seconds) appear along the series axis (y-axis). 
 The column headings (temperatures) appear along the category axis (x-axis). 
 The data in the center of the worksheet (tensile strength) will be plotted along the value axis 

(z-axis). 

 
 
4.4.1 Surface chart types 
A Surface chart can be displayed in different ways by selecting the following chart sub-types: 
 3-D Surface – This chart shows a 3-D view of the data, which could be imagined as a rubber 

sheet stretched over a 3-D Column chart. It is typically used to show relationships between 
large amounts of data that may otherwise be difficult to see.  

 Wireframe 3-D Surface – A variation of the 3-D Surface chart that appears in black and white. 
Without color in the surface, a wireframe chart shows only the lines.  

 Contour – A Contour chart provides a 2-D view of the Surface chart from above, similar to a 
2-D topographic map. The lines in a Contour chart connect interpolated points of equal value.  

 Wireframe Contour – A variation of the Contour chart that appears in black and white. Without 
color in the surface, a wireframe chart shows only the lines. 
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4.4.2 Create a Surface chart 
1. Select the data you want to display in a Surface or Contour chart.  
2. Click Insert  Chart.  
3. In the Chart type box, click Surface.  
4. Under Chart sub-type, click the type you want to use. For a quick preview of the chart you 

are creating, click [Press and Hold to View Sample]. 
5. Click [Next], and continue with steps 2 – 4 of the Chart Wizard.  
 
4.4.3 Changing the format of a Surface chart 
Because the colors in a Surface chart are based on the values rather than the data series, you cannot 
select them in the chart itself. You can, however, select the corresponding color keys in the chart's 
legend, and then make the formatting changes you want in the Format Legend Key dialog box. 
Using this dialog box, you can: 
 Change the colors and patterns used in the chart.  
 Reorder the data series.  
 Change the depth of the chart. 

 
4.4.4 Format a Surface chart 
1. To display the legend, click Chart  Chart Options, and then select the Show legend check 

box on the Legend tab.  
2. In the legend, click the key for which you want to change the format.  
3. On the Format menu, click Selected Legend Key.  
4. On the Patterns tab, make the color, border, or fill effect changes you want.  
5. Repeat step 2-4 for each level you want to format.  
6. To change the order of the data series in the chart, click the Series Order tab, click a series 

name in the Series order box, and then click the [Move Up] or [Move Down] buttons.  
7. To change the depth of the Surface chart, click the Options tab, and then type a value between 

20 - 2000 in the Chart depth box. By default, the depth of the Surface chart is set to 100. 
8. To add a 3-D shading effect to the Surface chart, on the Options tab, select the 3-D shading 

check box.  
You can see the effects of your changes in the preview box on the Series Order tab or the Options 
tab. The number of colors shown in a Surface chart is dependent on the scale settings of the value 
axis. Changes you make to a Surface chart may affect the size of the chart and those scale settings, 
showing more or fewer colors. 
 

4.5 Bubble Charts 
A Bubble chart is a variation of a Scatter chart in which the data points are replaced with bubbles. A 
Bubble chart can be used instead of a Scatter chart if your data has three data series, each of which 
contains a set of values.  
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For example, the worksheet in the following picture contains values for three types of data: number 
of products, dollar value of sales, and percentage size of market share. 

 

In a Bubble chart, the size of the bubbles is determined by the values in the third data series. For 
example, the following Bubble chart displays bubble sizes that correspond to the values in the third 
column of the sample data (Market share %). 

 
Notice that the data in this Bubble chart is plotted as follows:  
 Number of products is displayed along the horizontal (x) axis.  
 Sales amounts are displayed along the vertical (y) axis.  
 Market share percentages are represented by the size of the bubbles. 

 
4.5.1 When to use a Bubble chart 
Bubble charts are often used to present financial data. Use a Bubble chart when you want specific 
values to be more visually represented in your chart by different bubble sizes. Bubble charts are 
useful when your worksheet has any of the following types of data: 
 Three values per data point – Three values are required for each bubble. These values can be 

in rows or columns on the worksheet, but they must be in the following order: x value, y value, 
and then size value.  

 Negative values – Bubble sizes can represent negative values, although negative bubbles do 
not display in the chart by default. You can choose to display them by formatting that data 
series. When they are displayed, bubbles with negative values are colored white (which cannot 
be modified) and the size is based on their absolute value. Even though the size of negative 
bubbles is based on a positive value, their data labels will show the true negative value.  

 Multiple data series – Plotting multiple data series in a Bubble chart (multiple bubble series) 
is similar to plotting multiple data series in a Scatter chart (multiple scatter series). While 
Scatter charts use a single set of x values and multiple sets of y values, Bubble charts use a 
single set of x values and multiple sets of both y values and size values. 
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4.5.2 Create a Bubble chart 
1. Select the data you want to display in the Bubble chart. It's best not to include row or column 

headings in the selection. Otherwise, the chart may produce incorrect results. 
2. Select Insert  Chart. In the Chart type box, click Bubble.  
3. Under Chart sub-type, click the chart sub-type you want to use. For a quick preview of the 

chart you are creating, click [Press and Hold to View Sample]. 
4. Click [Next], and continue with steps 2 – 4 of the Chart Wizard. Note that smaller bubbles 

may be hidden by larger bubbles, making it seem that Excel has not drawn all of the data 
markers. When an entire data series contains negative bubble sizes, the series is not displayed 
by default. If you want to see the negative bubbles, select the series you want in the Chart 
Objects list on the Chart toolbar, and then click Format Data Series on the same toolbar. On the 
Options tab, select the Show Negative Bubbles check box. 

 
4.5.3 Formatting Bubble charts 
There are several ways to change the format of a Bubble chart: 
 Display bubbles with a 3-D visual effect – By selecting the 3-D Bubble chart sub-type, 

bubbles are formatted with a 3-D visual appearance. A 3-D Bubble chart is 3-D in appearance 
only — it actually remains a 2-D chart type. Unlike other 2-D chart types, however, this chart 
type cannot be used in a combination chart. 

 Adjust the size of bubbles – The size of the bubbles can represent the area of the bubbles or 
the width of the bubble, which affects the relative size of one bubble to another. The Width of 
bubbles option can be used for representations such as market share between products. You can 
also scale the bubble size for a data series by specifying a percentage between 0 and 300 — the 
larger the percentage, the larger the bubbles. 

 Display error bars – To graphically express potential error amounts relative to each bubble in 
a bubble series, you can display error bars for the X values, the Y values, or both.  

 Change the color and fill effects of bubbles – You can assign different colors and fill effects 
(such as pattern, texture, and gradient) to individual bubbles or an entire bubble series.  

 Replace bubbles with pictures – You can replace each bubble or all bubbles in a series with a 
picture. The size of the picture is automatically adjusted to match the bubble size for each 
corresponding value.  

  
4.5.4 Change the Color and Pattern of Bubbles 
1. In the Bubble chart, select a bubble or bubble series.  
2. Click Format  Selected Data Point or Format  Selected Data Series.  
3. On the Pattern tab, select the options you want.  
4. To change the gradient, texture, or pattern of bubbles, click Fill Effects, and then select the 

options you want on the Gradient, Texture, or Pattern tab. To use pictures instead of bubbles, 
click the Picture tab, and then click Select Picture to insert the picture you want. 
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4.6 Pie of Pie and Bar of Pie Charts 
Pie charts are excellent for displaying data points as a percentage of the whole. However, when 
several data points each amount to less than 5% of the pie, it becomes hard to distinguish the slices. 
For example, a pie chart of the following sales data contains three slices that fall below 5%. 

  
To make smaller slices more visible in a pie chart, Excel provides the Pie of Pie and Bar of Pie chart 
sub-types. Each of these chart sub-types separates the smaller slices from the main pie chart and 
displays them in an additional pie or stacked bar chart, as shown in the next picture. 

 

Notice that the percentage labels in the secondary pie chart display the same numbers as in the 
regular pie chart. The numbers only represent the individual slices that were moved to the 
secondary chart; they do not total 100%. 
 
4.6.1 Setting up your data and creating the chart 
Pie charts can display only one data series, which means you can include only one column or row of 
values in your selection when you create a pie chart. You can also include a row or column of 
categories, as long as it is the first column or row in the selection.  
When you select the Pie of Pie or Bar of Pie chart sub-type, Excel moves the last third of the data 
points into the secondary chart by default. For example, if there are nine data points, the last three 
points in your selection are plotted in the secondary chart. However, after the initial chart is created, 
you can change the number of data points in the secondary chart by changing settings on the 
Options tab of the Format Data Series dialog box.  
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4.6.2 Create a Pie of Pie or Bar of Pie chart 
1. Select the data that you want to display in the Pie of Pie or Bar of Pie chart.  
2. Click Insert  Chart.  
3. In the Chart type box, click Pie.  
4. Under Chart sub-type, click Pie of Pie or Bar of Pie. For a quick preview of the chart you are 

creating, click [Press and Hold to View Sample]. 
5. Click [Next], and continue with Steps 2 – 4 of the Chart Wizard.  
Depending on how many decimal places are specified for percentages on the Number tab of the 
Format Cells dialog box (Format menu, Cells command), percentages that are displayed in data 
labels may be rounded so that they don't add up correctly. 
 
4.6.3 Customizing the way data points are displayed 
You can format specific chart elements of a Pie of Pie or Bar of Pie chart the same way you would 
in a regular pie chart. However, there are a few things that are unique to Pie of Pie and Bar of Pie 
charts: 
 Position of primary and secondary charts – The primary and secondary charts are always 

positioned horizontally and adjacent to each other. They cannot be moved separately. The left 
chart is always the primary chart, but it's not always the larger of the two charts — the 
secondary chart can be larger than the primary chart.  

 Selection of primary and secondary charts – You cannot select the individual charts or 
format them separately. Both primary and secondary charts are part of one data series. You can 
only select the entire data series or its individual data points, and then apply formatting to the 
selection.  

 Connector lines – Connector lines are automatically added to emphasize the association 
between the two charts. You can format them by applying different line styles. You can also 
remove them if you need to.  

  
4.6.4 Change Pie of Pie or Bar of Pie data series options 
1. In the chart, select the entire data series. To select the entire data series, make sure nothing else 

is selected, and then click either of the charts once. 
2. Click Format  Selected Data Series.  
3. Click the Options tab.  
4. To specify what kind of data you want in the secondary chart, click an option in the Split 

series by box.  
5. To adjust the number of data points that appear in the secondary chart, do one of the following:  

 If you chose to split the series by position, change the number in the Second plot 
contains the last [ ] values box.  

 If you chose to split the series by value or percent value, change the number in the 
Second plot contains all values less than box.  

 If you want to customize the split of the data, close the dialog box, and then use the 
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mouse to drag pieces between the two charts. The slice in the primary chart that 
represents the data in the secondary chart cannot be moved into the other chart. If you 
drag a slice from a pie chart without placing it in the other chart, space is created between 
the slices. 

6. To change the size of the secondary chart, increase or decrease the number in the Size of 
second plot box (This number represents size as a percentage of the primary chart size).  

7. To remove the connector lines, clear the Series lines check box.  
8. To use the same color for all data points, clear the Vary colors by slice check box. You can 

change the color of individual data points. Select the piece that you want to change, and then, 
on the Format menu, click Selected Data Point. On the Patterns tab, under Area, click the color 
you want to use.  

9. To change the space between the charts, increase or decrease the number in the Gap width box 
(This number represents gap width as a percentage of the secondary chart width). 

 
 

4.7 Gantt Chart 
There are many ways to create a Gantt chart. For example, Microsoft Project, a task-planning 
program, makes it easy to track and chart project timelines with a built-in Gantt chart view. Another 
option is to use Excel. Excel does not contain a built-in Gantt chart format; however, you can create 
a Gantt chart in Excel by customizing the stacked bar chart type. 
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4.7.1 Step 1: Enter the sample data 
Open a new worksheet in Excel and enter the values in cells, then format with the date format you 
want to use for the chart by clicking Cells on the Format menu, and then clicking the Number tab. 
Click Date in the Category list, and select the format you want to use in the Type list.  

Task Start Date Duration (days) End Date 
Task 1    
Task 2    
Task 3    

 
4.7.2 Step 2: Create a stacked bar chart 
1. Select the data source, click Insert  Chart to activate Chart Wizard, and select Stacked Bar 

as the chart type 
2. Remove all data series, and then recreate two data series:  

 Create a new series for the column of Start Date 
 Create a new series for the column of Duration 

3. Press [Finish] to create the chart. 
 
4.7.3 Step 3: Make the chart look like a Gantt chart 
1. Double-click the first series in the chart. This is the series for Start Date.  
2. On the Patterns tab of the Format Data Series dialog box, click None for Border and None 

for Area, and then click [OK].  
3. Double-click the category (x) axis, which in a bar chart is the vertical axis. Click the Scale tab, 

and select the Categories in reverse order check box.  
4. Double-click the value (y) axis, which in a bar chart is the horizontal axis. Click the Scale tab 

and type the following values in the appropriate boxes: Minimum, Maximum, Major unit 
and Minor unit. 

5. Within the legend, select Start Date and then press [Delete].  
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5. Available Chart Types 
 
Microsoft Excel supports many kinds of charts to help you display data in ways that are meaningful 
to your audience. When you use the Chart Wizard to create a chart, you can easily select the type 
you want from a list of standard or custom chart types. 
 

5.1 Column charts 
A column chart shows data changes over a period of time or illustrates comparisons among items. 
Column charts have the following chart sub-types: 
 
5.1.1 Clustered Column 
This type of chart compares values across categories. It is also 
available with a 3-D visual effect. As shown in the following chart, 
categories are organized horizontally, and values vertically, to 
emphasize variation over time  
 
5.1.2 Stacked Column    
This type of chart shows the relationship of individual items to the 
whole, comparing the contribution of each value to a total across 
categories. It is also available with a 3-D visual effect.  

 
 
5.1.3 100% Stacked Column    
This type of chart compares the percentage each value contributes to 
a total across categories. It is also available with a 3-D visual effect. 
 

 
 
5.1.4 3-D Column    
This type of chart compares data points along two axes. For 
example, in the following 3-D chart, you can compare four quarters 
of sales performance in Europe with the performance of two other 
divisions.  
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5.2 Bar Charts 
A bar chart illustrates comparisons among individual items. Bar charts have the following chart 
sub-types: 
 
5.2.1 Clustered Bar 
This type of chart compares values across categories. It is also 
available with a 3-D visual effect. In the following chart, categories 
are organized vertically, and values horizontally, to place focus on 
comparing the values.   
 
5.2.2 Stacked Bar 
This type of chart shows the relationship of individual items to the 
whole. It is also available with a 3-D visual effect 

 
 
5.2.3 100 % Stacked Bar 
This type of chart compares the percentage each value contributes to 
a total across categories. It is also available with a 3-D visual effect.

 
 

5.3 Line charts 
A line chart shows trends in data at equal intervals. Line charts have the following chart sub-types: 
 
5.3.1 Line    
This type of chart displays trends over time or categories. It is also 
available with markers displayed at each data value.  

 
 
5.3.2 Stacked Line 
This type of chart displays the trend of the contribution of each 
value over time or categories. It is also available with markers 
displayed at each data value.  
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5.3.3 100% Stacked Line 
This type of chart displays the trend of the percentage each value 
contributes over time or categories. It is also available with markers 
displayed at each data value.  

 
 
5.3.4 3-D Line 
This is a line chart with a 3-D visual effect.  
 

 
 

5.4 Pie charts 
A pie chart shows the size of items that make up a data series, proportional to the sum of the items. 
It always shows only one data series and is useful when you want to emphasize a significant 
element in the data. Pie charts have the following chart sub-types: 
 

5.4.1 Pie    
This type of chart displays the contribution of each value to a total. 
It is also available with a 3-D visual effect. 

 
 
5.4.2 Exploded Pie    
This type of chart displays the contribution of each value to a total 
while emphasizing individual values. It is also available with a 3-D 
visual effect.  

 
 
5.4.3 Pie of Pie    
This is a pie chart with user-defined values extracted and combined 
into a second pie. E.g. to make small slices easier to see, you can 
group them together as one item in a pie chart and then break down 
that item in a smaller pie or bar chart next to the main chart.  
 
5.4.4 Bar of Pie    
This is a pie chart with user-defined values extracted and combined 
into a stacked bar. 
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5.5 XY (Scatter) charts 
An xy (scatter) chart shows the relationships among the numeric values in several data series, or 
plots two groups of numbers as one series of xy coordinates. Scatter charts are commonly used for 
scientific data and have the following chart sub-types: 
 
5.5.1 Scatter    
This type of chart compares pairs of values. When you arrange your 
data for a scatter chart, place x values in one row or column, and 
then enter corresponding y values in the adjacent rows or columns. 

 
 
5.5.2 Scatter with Data Points Connected by Lines 
This type of chart can be displayed with or without straight or 
smoothed connecting lines between data points. These lines can be 
displayed with or without markers.  

 
 

5.6 Area charts 
An area chart emphasizes the magnitude of change over time. Area charts have the following chart 
sub-types:  
 

5.6.1 Area    
This type of chart displays the trend of values over time or 
categories. It is also available with a 3-D visual effect. By 
displaying the sum of the plotted values, an area chart also shows 
the relationship of parts to a whole..  
 
5.6.2 Stacked Area    
This type of chart displays the trend of the contribution of each 
value over time or categories. It is also available with a 3-D visual 
effect. 

 
 
5.6.3 100% Stacked Area    
This chart type displays the trend of the percentage each value 
contributes over time or categories. It is also available with a 3-D 
visual effect.  
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5.7 Doughnut Charts 
Like a pie chart, a doughnut chart shows the relationship of parts to a whole; however, it can 
contain more than one data series. Doughnut charts have the following chart sub-types:  
 
5.7.1 Doughnut    
This type of chart displays data in rings, where each ring represents 
a data series.  
 

 
 
5.7.2 Exploded Doughnut   
This chart type is like an exploded pie chart, but it can contain more 
than one data series.  
 

 
 

5.8 Radar charts 
A radar chart compares the aggregate values of a number of data series. Radar charts have the 
following chart sub-types:  
 
5.8.1 Radar    
This type of chart displays changes in values relative to a center 
point. It can be displayed with markers for each data point.  

 
 
5.8.2 Filled Radar    
In this type of chart, the area covered by a data series is filled with a 
color.  
 

 
 

5.9 Surface Charts 
A surface chart is useful when you want to find optimum combinations between two sets of data. As 
in a topographic map, colors and patterns indicate areas that are in the same range of values. 
Surface charts have the following chart sub-types: 
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5.9.1 3-D Surface    
This type of chart shows trends in values across two dimensions in a 
continuous curve. The colors in this chart represent specific ranges 
of values. Displayed without color, a 3-D surface chart is called a 
wireframe 3-D surface chart.  
 
5.9.2 Contour    
This is a surface chart viewed from above, where colors represent 
specific ranges of values. Displayed without color, this chart type is 
called a Wireframe Contour.  

 
 

5.10 Bubble Charts 
A bubble chart is a type of xy (scatter) chart. It compares sets of 
three values and can be displayed with a 3-D visual effect. The size 
of the bubble, or data marker, indicates the value of a third variable. 
To arrange your data for a bubble chart, place the x values in one 
row or column, and enter corresponding y values and bubble sizes 
in the adjacent rows or columns. E.g. you would organize your data 
as shown in the following picture. 

 

 

5.11 Cylinder, Cone, or Pyramid charts 
These chart types use cylinder, cone, or pyramid data markers to lend a dramatic effect to column, 
bar, and 3-D column charts. Much like column and bar charts, cylinder, cone, and pyramid charts 
have the following chart sub-types: 
 
5.11.1 Column, Stacked Column, or 100% Stacked Column    
The columns in these types of chart are represented by cylindrical, 
conical, or pyramid shapes. 

 
 
5.11.2 Bar, Stacked Bar, or 100% Stacked Bar    
The bars in these types of chart are represented by cylindrical, 
conical, or pyramid shapes. 
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5.11.3 3-D Column    
The 3-D columns in this type of chart are represented by cylindrical, 
conical, or pyramid shapes. 

 
 

5.12 Stock Charts 
This chart type is most often used for stock price data, but can also be used for scientific data (for 
example, to indicate temperature changes). You must organize your data in the correct order to 
create stock charts. Stock charts have the following chart sub-types:  
 
5.12.1 High-Low-Close    
The high-low-close chart is often used to illustrate stock prices. It 
requires three series of values in the following order (high, low, and 
then close).  
 
 
5.12.2 Open-High-Low-Close    
This type of chart requires four series of values in the correct order 
(open, high, low, and then close).  

 
5.12.3 Volume-High-Low-Close    
This type of chart requires four series of values in the correct order 
(volume, high, low, and then close). The following stock chart 
measures volume using two value axes: one for the columns that 
measure volume, and the other for the stock prices.  

 
 
5.12.4 Volume-Open-High-Low-Close    
This type of chart requires five series of values in the correct order 
(volume, open, high, low, and then close).  
 

 
 


